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Overview

Triumph's Outlook plugin allows you to extend Rock’s reach right into your inbox. This plugin allows you to
view information about the sender next to the email they've sent. Keep in mind that this pluginis for Outlook.
It's not necessarily limited to Microsoft 365 or Exchange. Any Outlook supported inbox should work.

Below are a couple of notes to be aware of:

1. This add-in works on Windows, Mac and the Outlook.com website. It does not yet work in the mobile
applications. This is being considered for a future version. Interest in this plugin will drive the pace of
future development.

2. Dark mode is not an option. This is a technical limitation in the Outlook integration. We're interested in
working around this, but more time will be needed. This too is a task that will be dependent on
community interest (re: funding) of this plugin.

Licensing Policy

We prefer to spend our time working on ministry features vs licensing code. Currently, there is no check for
a current license. Use of this plugin is on the honor system. If you stop your subscription you must remove
the add-inin your Outlook clients or update the Rock security to prevent it from working.

Configuring the Plugin

Before you deploy the plugin to your team, you'll want to configure that plugin in your Rock instance. You'll
find the add-in's configuration screen under “Admin Tools > Installed Plugins > Outlook Add-in".
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Below are notes on the various configuration options.

1. Manifest Address: You'll need this when you are deploying your add-in to your Outlook clients. More
details on how this is done can be found below.

2. Security Role: This configuration allows you to limit who is able to access the plugin based on
membership in a Rock security role. As you'll see later, you'll also be able to manage this in Microsoft
365, but we also wanted to provide an additional security setting within Rock.

3. Add-in Icon: The next setting controls the icon that will be used for the add-in. This defaults to the
Rock icon, but you can change it if you'd like. You'll want to ensure that you update this icon before
you deploy your add-in as Outlook caches this setting.



4. App Domains: (This setting can be ignored unless you plan to customize the add-in yourself.) This
setting determines which domains should be considered a part of your add-in. We auto add your
internal application root domain. URLs for domains in this list will open inside of the add-in's task
pane window. Domains not on this list will open in a new browser window. When adding the domains
be sure to follow these rules:

a. Include the protocol (https://)

b. Do not provide a trailing slash

External Authentication Providers
If you use an external authentication provider, you'll want to add their domains to this list. For example, if
you use Microsoft 365/Azure AD you'll want to add "https://login.microsoftonline.com” to this list.

5. Application Pages: We've provided links to the Rock pages that the add-in uses. This allows you to
customize the pages to extend their capabilities. See the Customize the Add-in section below for more
details.

Page Security

You'll need to ensure that the security on the [Profile Page] and [Workflow Entry Page] are adjusted to
work with the individuals using the application.

Site Configuration

In order for the Outlook Add-in to work on Outlook.com (website) you'll need to also complete the following
steps:

1. Edit the Internal Rock RMS site under "Admin Tools > CMS Configuration > Rock RMS".

2. Ensure that the Internal App Root is in the domain list.

3. Update the “Allowed Frame Domain(s)” to include the Internal App Root, “outlook.office.com” and
"outlook.office365.com”.
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Advanced Settings

Enable Mobile Redirect Allow Indexing ©@
Log Page Views Crawling Starting Location @
Page View Retention Period @ Enable Exclusive Routes @
60
Allowed Frame Domain(s) @ Enable Page View Geo Tracking @

outlook.office365.com
rock.rocksolidchurchdemo.com

Disable Predictable Ids @

Additionally, the "Same Site Cookie Setting” global attribute will need to be set to “None".
Deploying the Plugin
You can deploy this plugin in one of two ways. Each is discussed below.

Single Person Installation

If you're wanting to test the add-in out personally, or you're not a part of a Microsoft 365 organization you
will need to install the add in on an individual basis. To do this open Outlook and follow the instructions

below:

1. Click the "Get Add-ins" button in the Outlook ribbon.

|
Get
Add-ins

Add-ins
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2. This will bring up the Add-ins Configurations screen. Select "My add-ins” and then “"Add a custom add-

sAl
mn-.
ADD-INS CONNECTORS
Add-ins may access personal information. By turning an add-in on, you agree to its License Terms and Privacy Policy. ,O Search add-ins
Al My add-ins
My add-ins

Admin-managed Store Add-ins
Add-ins that you added from the Office store

No add-ins found.

Admin Managed

Add-ins deployed by your administrator. Browse all admin-managed add-ins

‘ Unsubscribe Suqgqested Meetings D My Templates
This add-in is triggered by messages Shows meeting suggestions found in

from subscription email feeds, and your email and allows you to add them

allows you to block the sender or to your calendar. This add-in will not

Admin-managed Admin-managed Admin-managed

@ rdded oo @ Added coo @ Added

E.|:> Bing Maps I’ Action Items

Map addresses found in your email. Shows Action Item suggestions from
This add-in will send addresses to Bing your email. This add-in will not share
but will not share your data with any your data with any third-party service.
Admin-managed Admin-managed

@ dded s @ Added

Custom Addins

You can install add-ins from a file or from a URL. - Add a custom add-in

E Add from URL... I
' Triumph “M
A ‘ Add from File... ‘

This add-in adds the power of Rock
RMS to your Inbox.

Custom add-in

@ rdded

3. Select the “Add from URL" and then paste in the manifest URL from the plugin configuration page in
Rock. After selecting “OK" your add-in will be configured, and you're done.

Microsoft 365 Administrative Deployment

If you are running in a Microsoft 365 environment, deploying the add-in is a breeze. Simply follow the steps
below to deploy the Outlook Add-in to your teams.

1. Openthe Microsoft 365 Admin portal at https://admin.microsoft.com

2. Head to “Settings > Integrated apps”.
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https://admin.microsoft.com/

3. Click the "Upload custom apps" link

Microsoft 365 admin center R search

= Home > Integrated apps 2 Dark mode
@ Home
Integrated apps
R users v
Discover, purchase, acquire, manage, and deploy Microsoft 365 Apps developed by Microsoft partners. You can also deploy and manage Line-of-business add-ins developed within your organization.
£ Devices ™ For advanced management of these apps go to the respective admin center or page : Azure Active Directory | SharePoint | Teams | Add-ins
8 Teams & groups v
Deployed apps
& siling v _
® s o All apps in this list have been installed for tenant users. Note that Teams apps are not deployed but are available in the store for users to install
&% Settings ~ Popular apps to be deployed A
Domains . " . . o .
N Adobe Acrobat Sign f... Office2SharePoint for ... officeatwork | Templat... iPlanner Pro For Office...
Search & intelligence Web apps @ @ Outlook ] [T L) @ B Web apps @
Org settings Get more done by sending and signing Office2SharePoint - working with SharePoint Access your centrally shared templates in Get Planner tasks from Planner & Microsoft
documents all from within M365 apps. and Teams the easy way Office, Teams, SharePoint Online, and other. Teams at the tip of your hand in Outlook on.
I Integrated apps
Partner relationships
2 setup

View more apps

Admin centers

B Endpoint Manager [ Getapps | T Upload custom apps | () Refresh 2items | O Search < Filter =

4@ Azure Active Directory

Name Host products Status Test deployment Last modified |
- Showall & Calendly makes scheduling super easy! s ou " N
jeb apps ore apps available o
Scheduling automation you and your invitees will actually enjoy!
Adobe Creative Cloud
F Web apps, Teams © More apps available No

Creative Cloud gives you everything you need to turn your brightest ideas into y.

4. Select "Provide link to manifest file” and paste in the URL to your manifest then click “Validate"” and

finally “Next". This link is available in the plugin configuration within Rock.

5. You'll then be able to select who you'd like to deploy the add-in to.

Deploy New App

@ Upload custom app Add users

@ Users

| " Triumph
O Deployment
Is this a test deployment? © (@ ) No

Assign users
(O Just me (jon@triumph.tech)
(O Entire organization

(O specific users/groups

‘ Search for users or groups to add

Back Next Cancel
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6. Finally, the add-in will be deployed to the individuals you've selected.

Using the Add-in

Once you've deployed your add-in, you'll see a new button in the Outlook ribbon with the add-in icon with the
label "Show Profile". This button will only be enabled when an email is selected, and a message is shown in
the reading pane. This will open a task pane with will show you the Rock record that matches the address the

sent the email.

By default, the task pane will close when you switch emails. If you'd like for it to remain open simply pin the
task pane by clicking the pingiconin the top right.

Triumph R ox

Ted Decker /

A

Age: 38
Member Main Campus “
& Artinnc A4

Below is an example of a profile for a sender whose address is in Rock.
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E £ search

| = Fle Home Send/Receive Folder View Help
LS @] OReply  [F
M & =
New New %Y O Reply All by v
Email ltemsv QL — Forward [y v

Delete Archive

RQ

New Delete Respond

<

I’i] Move to: ?
2T Manager
] Team Email

Quick Steps

4 Move v A8 New Group [Search People | A
2 Rules v Tags A8 Browse Groups [B] Addiress Book Read
] send to OneNote Y Fitter Email v Aloud
Move Groups Find Speech

Update on the Next Step Class
IR
Ted Decker

To: Alisha Marble 9/27/2022

Leverage agile frameworks to provide a robust synopsis for high level
overviews. Iterative approaches to corporate strategy foster collaborative
thinking to further the overall value proposition. Organically grow the holistic

world view of disruptive innovation via workplace diversity and empowerment.

Bring to the table win-win survival strategies to ensure proactive domination.
At the end of the day, going forward, a new normal that has evolved from
generation X is on the runway heading towards a streamlined cloud solution.
User generated content in real-time will have multiple touchpoints for
offshoring.

Capitalize on low hanging fruit to identify a ballpark value added activity to
beta test. Override the digital divide with additional clickthroughs from
DevOps. Nanotechnology immersion along the information highway will close
the loop on focusing solely on the bottom line.

Let's take a look at each section of the Rock integration to see what's possible.

Bio Section

Ted Decker
Age: 38

Member Main Campus

%  (623) 555-3344 Mobile

Badges
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| & Coming Soon‘ Try it now @

2B QD

Translate Get Show Viva
v Add-ins  Profile Insights
Language = Add-ins | RockRMS  Add-in v
Rock RMS rox
Ted Decker
Age: 38
Member  Main Campus Z
o
% Actions v
A 2 ®§
Cindy Noah Alex
37 10 7

Bookmarked Attributes

Baptism Date
9/13/2001

Baptized Here
No

Do Not Send Giving Statement
No

Write a note...

Alert: Personal Note

“ Alisha Marble
@ Personal Note - 8 years ago

Called Ted and heard that his mother is in
the hospital and could use prayer.

A Admin Admin

This section shows basic information about the individual.

e Phone number allows you to quickly convert the

email to a more personal phone call.

e The arrowicon will display the full Rock profilein a

new window.
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This section shows a limited set of badges. You can

@ customize this to show badges you've already developed.
When customizing this block it's important to note that we
only show badges in the lower bar of the block.

Actions

The Actions section allows you to launch workflows right
from Outlook. These workflows will execute right in the task
pane even allowing you to complete forms right inside of
Outlook. Which workflow types that are displayed here are
B Facilities Request based on a block setting and respect security.

& Actions A

o/ External Inquiry

CJ IT Support

& Profile Change Request

Primary Family

This section shows the individuals in the person’s primary

a N €\ family.
13 ey
| i
Cindy Noah Alex
37 10 7

Bookmarked Attributes

The bookmarked attributes section allows the display of a

Bookmarked Attributes small subset of attributes. The attributes listed are
Baptism Date customizable for each individual using the add-in. The
9/13/2001 configured attributes are also specific to the Outlook add-in

which allows an individual to customize them for their task

Baptized Here needs within Outlook.

No

Do Not Send Giving Statement
No

Notes
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Write a note...

The final section is for notes. This will display notes for the
sender. It also allows you to add new notes right from

Outlook.

Alert: Personal Note

Alisha Marble

@ Personal Note - 8 years ago

Called Ted and heard that his mother is in

the hospital and could use prayer.

If there is no matching record in Rock for the senders email a button will be displayed that allows you to add a

new record to Rock.

Send / Receive  Folder

I =

Delete Archive

|IZI File
— (& ™
M P

S

New Delete

Home

New New
Email Items v

£ Search

View  Help
OReply  [H
& Reply All oy v
= Forward £y v
Respond
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4 Move to: 2
—> To Manager
™ Team Email

Quick Steps

EL'I Move ¥
v BRulesv

‘Search People
[B] Address Book
N Filter Email ¥

|:t| %f New Group

A
& Browse Groups Read
Aloud

Tags
@] Send to OneNote
5 Move

Groups Find Speech

Update on the Next Step Class
Ted Decker
To: Alisha Marble

Leverage agile frameworks to provide a robust synopsis for high level
overviews. Iterative approaches to corporate strategy foster collaborative
thinking to further the overall value proposition. Organically grow the holistic
world view of disruptive innovation via workplace diversity and empowerment.

© 9 9=

9/27/2022

Bring to the table win-win survival strategies to ensure proactive domination.
At the end of the day, going forward, a new normal that has evolved from
generation X is on the runway heading towards a streamlined cloud solution.
User generated content in real-time will have multiple touchpoints for
offshoring.

Capitalize on low hanging fruit to identify a ballpark value added activity to
beta test. Override the digital divide with additional clickthroughs from
DevOps. Nanotechnology immersion along the information highway will close
the loop on focusing solely on the bottom line.

11

n - [m] X
‘ /4 Coming Soon‘ Try it now @

2B O 9

Translate Get Show Viva
v Add-ins  Profile  Insights

Language = Add-ins | RockRMS  Add-in v
Rock RMS 5 ox

Could not find a matching person for

the email address linder@thecause.org.

‘Add Person
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Customizing the Add-in

We've worked hard to deliver an experience that provides a lot of power for your team. However, like
everything in Rock, you can customize it to take it to the next level.

The pages that display in the Outlook Add-in are simply Rock pages that are styled for to match the Outlook
environment. You can add to these pages to suite your needs.

Important Tips

1. Werecommend that you keep your customizations to block settings until we reach version 2.0 of the
plugin as we'll be adding new capabilities. These changes will likely require us to update the Lavain
the existing blocks which would over-write your customizations.

2. If you absolutely do need to change the Lava we recommend that you clone the profile page we ship
with and move the route. This will allow us to update our shipped page without over-writing your
customizations. You can then see what we changed and make the same changes to your custom pages.
Again, if at all possible please refrain from changing the Lava templates for now.

Technical Notes

Below are some technical notes on using the plugin. You should not need these details unless you do
advanced configuration changes.

Outlook.com

When using Outlook web edition there are a few notes you'll want to be aware of.

1. Safari: On Safari you'll need to disable the prevention of cross-site tracking to complete the login
process. See the link below for instructions:
https://support.apple.com/guide/safari/prevent-cross-site-tracking-sfri40732/mac

Caching

Outlook Add-ins rely heavily on cache for speed. This is a good thing but can frustrating when developing.
Below are a few tips to help you get around caching issues. If you're finding that the changes you made while
developing are not being served try these steps to flush the cache:

1. Windows - Delete the contents of the following folder on the client machine.
%LOCALAPPDATA%\Microsoft\Office\16.0\Wef\
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2. Mac - Follow the instructions found on this webpage:
https://learn.microsoft.com/en-us/office/dev/add-ins/testing/clear-cache#clear-the-cache-manually

Release Notes

V1.0

e |nitial release.
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